Agile Product Lifecycle Management

Database Installation Guide
v9.3.2

ORACLE

Part No. E28670-01
December 2012



Copyright and Trademarks
Copyright © 1995, 2012, Oracle and/or its affiliates. All rights reserved.

This software and related documentation are provided under a license agreement containing
restrictions on use and disclosure and are protected by intellectual property laws. Except as
expressly permitted in your license agreement or allowed by law, you may not use, copy,
reproduce, translate, broadcast, modify, license, transmit, distribute, exhibit, perform, publish or
display any part, in any form, or by any means. Reverse engineering, disassembly, or decompilation
of this software, unless required by law for interoperability, is prohibited.

The information contained herein is subject to change without notice and is not warranted to be
error-free. If you find any errors, please report them to us in writing.

If this software or related documentation is delivered to the U.S. Government or anyone licensing it
on behalf of the U.S. Government, the following notice is applicable:

U.S. GOVERNMENT RIGHTS

Programs, software, databases, and related documentation and technical data delivered to U.S.
Government customers are "commercial computer software" or "commercial technical data"
pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental
regulations. As such, the use, duplication, disclosure, modification, and adaptation shall be subject
to the restrictions and license terms set forth in the applicable Government contract, and, to the
extent applicable by the terms of the Government contract, the additional rights set forth in FAR
52.227-19, Commercial Computer Software License (December 2007). Oracle USA, Inc., 500
Oracle Parkway, Redwood City, CA 94065.

This software is developed for general use in a variety of information management applications. It is
not developed or intended for use in any inherently dangerous applications, including applications
which may create a risk of personal injury. If you use this software in dangerous applications, then
you shall be responsible to take all appropriate fail-safe, backup, redundancy and other measures
to ensure the safe use of this software. Oracle Corporation and its affiliates disclaim any liability for
any damages caused by use of this software in dangerous applications.

Oracle and Java are registered trademarks of Oracle Corporation and/or its affiliates. Other names
may be trademarks of their respective owners.

This software and documentation may provide access to or information on content, products and
services from third parties. Oracle Corporation and its affiliates are not responsible for and
expressly disclaim all warranties of any kind with respect to third party content, products and
services. Oracle Corporation and its affiliates will not be responsible for any loss, costs, or damages
incurred due to your access to or use of third party content, products or services. The RMW product
includes software developed by the Visigoth Software Society.



CONTENTS

COoPYrgNt AN TrAGEMAIKS ... .uueiiiiiiiiiiiiii s 2
Chapter 1 Overview of Agile Database Installation.......ccccouummemsimmmmmsssmmmesssnmnmnnssnmmnassn 1
QL= 53 QO A= V1= PP 1
Obtaining Software from Oracle Software Delivery CloUd ... 1
Obtaining Software from Oracle SUPPOIT ........u i 2
Downloading the Agile PLIM SOFtWATE ........c.ciirieeiese et es s 2
Chapter 2 Agile System Requirements ........cccciimmmmmsssmmmmmsssimmnsssmmmssssmmmsssssmmsasssssnnassann 3
Operating SYStEM REGUIFEMIENTS. ......uuuiiiiiiiiiiiiiiiiii s 3
Hardware REUIFEMENES .......oooiiiiiie 4
Database Hardware ConfiguIation............coooiiiiiiiiiiii 6
RAID CONfIQUIALION .....cooiiiiii i 7
Disk 1/O ConfiQUIALIONS .......coooiiiiieiee e 8
ONE-DISK ...ttt 9
FOUP-DiSK CONfIGUIATION. ...ttt ettt et e bt s e et b ne e bt en e e 9
NINE-DiSK CONTIGUIATION. .....cuiiiteieiit sttt ettt et b e et b e se b erenes 10
TWEIVE-DISK CONfIGUIATION. .......cuivitieicti sttt ettt bttt et b s et b s e s b ene e 11
Chapter 3 Installing Oracle Database Server......ccuisummmmmmmnsimammsmnssnnssnssnss s 13
Related DOCUMENTALION......uueiiiieeiiiirrie e et e e e s e e e e e e e e e e e e e e e s r e e e e e e e e s s annnnneees 13
Before Installing Oracle Database Server 0n WiNAOWS .........c.oovuvuiiiiiieeieiiiiiie e e e e e eeeaeeen 13
NEEWOTK CRECK ...t 14
Confirming Computer Name and HOStNAME..............uoiiiiiiiiiiiiiii e e e e e e e 14
Confirming the SEIVEI DA..........iiii i e e e e e e e e e eaaaaes 14
Checking the WINdOws File SYSIEM ..ot 14
For Servers Configured With DHCP ..ottt 15
Chapter 4 Installing the Agile Database on WIiNdOWS .....c.ccciimuimmsmmessmssmnsssssssssssnsssnasnes 17
INSEAIALION NOTES ....eeeiiiii ettt e et e e e e e e st r e e e e e e e e anbrn e e e e e e e e s e nnnnrnnees 17
Creating the Agile Database 0N WINOOWS..........uuuuuuiiiiiiiii s 17
Chapter 5 Installing the Agile Database on UNIX ........ccccoummmmessmmmmssssmmmsmsssmmmsssssssnnssssnn 21
Preparing the HOSt COMPULET .........cooiiiiieee e 21
Creating the Agile Database 0N UNIX..........uiii s 21
Chapter 6 Creating a RAC Database and Schema for Agile PLM............ccccunmmmmeusnnnnnannnn 27
Creating an Oracle RAC Database Instance for Agile PLM ... 27

Creating an Agile PLM Schema in an Existing RAC or Standalone Database Instance .................. 29



Post-INstallation TASKS ..ccrerrrerrmrmssmrsssesssssssssssssssssssssssssssnsssssssssnssssnssnsnssnsnssnsnnsnsnnnnsnnnnnnn 30

Adding and Configuring @ LISTENET...........coiiiiiiiiii i 30
Adding and Configuring @ Net SEIVICE ........ccoiiiiiiiiii 31
Setting Up Automatic Shutdown and Startup for the Database on UNIX ..........ccccviiiiiiiiiiiiiiiinnnnnn. 31
Setting Up Agile Recipe & Material Workspace Prerequisites in the Agile Database ...................... 32
Setting Up Optional Oracle FUNCHONANLY ...........uuiuiiiiiiiii s 32
Setting Up Oracle NEt MANAGET ........cv ettt ettt b et et s e s 32
Configuring Oracle ENterprise MANAGET ..........cviiiiiiiiieiieeeeeeee ettt 32
SEtliNG LEXEI PrEf@IENCE. ... .uuiiiiiiiiiii s 33
Setting up Enterprise Data Quality Product INtegration ............cccooeeviiiiiiiiinn e 34
Chapter 7 Database Management.........ccciuummmemimmmmmssimmmessmmmssssmmsssssmmsesssnnassssnnasssnns 35
Database MaINENANCE .........coviiieiiiiiie e e e e et e e e e e e et s e e e e eeeeaaa e e e eeeeeeeeaan e eeeaeeeenssnnaeeeeeeeennnnnn 35
MONEAIY MAINTENANCE ...ttt sttt e et s et et et e bt s et et e s e s e s et e b se et enene et enenes 35
Checking Database SPace AlIOCAHION .......cciiiiiiiiiieeeeee ettt 35
Dynamic Versus SatiC IP AQArESSES ... 36
Database BaCKUP.......ooooiiiiii 36
Backup and RECOVETY SITatBY......uiviviveriisicieeisi sttt b bbbt ben e e s enens 37
Implementing BaCKUP PTOCEAUIES .......cviviiiieiiciciceits ettt b et b s e ebens 38
TYPES OF BACKUDS ...ttt sttt sttt ettt a et bbbttt s ettt e bt R ettt e s ettt ne et et ene e 39
Performing SYSteM BaCKUPS ... ..ccoveuuiiiiiieeeiieeiiiee e e e e e e e et e e e e e e e e eett e e e e e e eeeaaanreeeeeeeeennnnnn 39

Using Standby Databases .........ccuuuiiiiiiiiiieiii e 39
Performing Database BaCKUPS. .........uuuuiiiieiiiiiiiiiiii i e e eeeeeetis s e e e e e e e et e e e e e e e eeaaae e e e eeeeeannnnnn 40
Performing Cold BaCKUPS .......oocoiiieeie e 40
Performing HOt BACKUPS ......uuiii i e e s e e e e e e e e e e e e e e e ea e e e e e e eeannnnns 41
Database IMpPort @nd EXPOIT..........uuuiiiiiiiiiieis e et e e e e e e e e e e e e e e e e e e e eeeaaaa e e eeeeeeennnns 41
Creating the Agile Schema and Importing the Database ..............ccccoiviiriiiiiiiccc e 41

[ g oTo] gl =T = 10 4[] (=T 43
Deleting an Instance and the Database FileS ...........cooviviiiiiiiii e 44
Running SQL Scripts Against the Agile PLM Schema ........cccooooviiiiiiiiiiiieccceiciee e, 45
EXPOItING the DAADASE .........coviveveeeieieieieieee ettt bbbttt 46
Exporting the Agile Schema from Oracle...........ccooiiiiiiiiiiciii e 46
Exporting the Full Oracle Database...........ccovvvuuiiiiiiiiecieeiie et e e e e eaaaaaas 48
010 = T = 10 0= (= P 48
DAtabase RECOVEIY......ccoiiiii i 49

USING Oracle RECOVETY MBNAGET ........c.oviveieieeeieieietetetetet ettt ettt ettt ettt ettt bbb s 49



Preface

The Agile PLM documentation set includes Adobe® Acrobat PDF files. The Oracle Technology
Network (OTN) Web site http://www.oracle.com/technetwork/documentation/agile-085940.html
contains the latest versions of the Agile PLM PDF files. You can view or download these manuals
from the Web site, or you can ask your Agile administrator if there is an Agile PLM Documentation
folder available on your network from which you can access the Agile PLM documentation (PDF)
files.

Note  To read the PDF files, you must use the free Adobe Acrobat Reader version 7.0 or later.
This program can be downloaded from the Adobe Web site http://www.adobe.com.

The Oracle Technology Network (OTN) Web site
http://www.oracle.com/technetwork/documentation/agile-085940.html can be accessed through Help
> Manuals in both Agile Web Client and Agile Java Client. If you need additional assistance or
information, please contact My Oracle Support (https://support.oracle.com) for assistance.

Note  Before calling Oracle Support about a problem with an Agile PLM manual, please have
the full part number, which is located on the title page.

TTY Access to Oracle Support Services

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the
United States of America 24 hours a day, 7 days a week. For TTY support, call 800.446.2398.
Outside the United States, call +1.407.458.2479.

Readme
Any last-minute information about Agile PLM can be found in the Readme file on the Oracle

Technology Network (OTN) Web site http://www.oracle.com/technetwork/documentation/agile-
085940.html

Agile Training Aids

Go to the Oracle University Web page
http://www.oracle.com/education/chooser/selectcountry _new.html for more information on Agile
Training offerings.

Accessibility of Code Examples in Documentation

Screen readers may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an otherwise empty line;
however, some screen readers may not always read a line of text that consists solely of a bracket or
brace.

This documentation may contain links to Web sites of other companies or organizations that Oracle
does not own or control. Oracle neither evaluates nor makes any representations regarding the
accessibility of these Web sites.


http://www.oracle.com/technetwork/documentation/agile-085940.html
http://www.adobe.com/
http://www.oracle.com/technetwork/documentation/agile-085940.html
https://support.oracle.com/
http://www.oracle.com/technetwork/documentation/agile-085940.html
http://www.oracle.com/technetwork/documentation/agile-085940.html
http://www.oracle.com/education/chooser/selectcountry_new.html




Chapter 1
Overview of Agile Database Installation

This chapter includes the following:

L I 1 QT TS 1
= Obtaining Software from Oracle Software Delivery Cloud ... 1
= Obtaining Software from Oracle SUPPOM.........ciiiiiiiiiieeeeeeee s 2

This chapter outlines the requisite tasks for successful installation of the Agile PLM Database and
provides information on accessing the necessary software.

Task Overview

The sequence of actions required for the installation process is as follows:

1. Prepare the installation environment. See Agile System Requirements on page 3.

2. Download the appropriate Oracle Database Server software. For download instructions, see
Obtaining Software from Oracle Support on page 2 (for a Patchset/Minipack), or Obtaining
Software from Oracle Software Delivery Cloud on page 1 (for a major release).

Install Oracle Database Server.

Download the Agile PLM Database Installer, which is part of the Agile PLM software
distribution. See Downloading the Agile PLM Software on page 2.

Note If you are installing the Agile Recipe and Material Workspace (RMW) database,
download and run the Agile RMW Database Installer.

5. Run the Agile PLM Database Installer. See Installing the Agile Database on Windows on page
17 or Installing the Agile Database on UNIX on page 21.

Obtaining Software from Oracle Software Delivery Cloud

Major Oracle product releases are distributed as Media Packs on Oracle Software Delivery Cloud
(http://edelivery.oracle.com). Refer to the Media Pack description or the list of products that you
purchased on your Oracle Ordering Document. Then, view the Quick Install Guide License List to
help you decide which Product Pack you need to select in order to search for the appropriate Media
Pack(s) to download. Prior to downloading, verify that the product you are looking for is in the
License and Options section of the Product Pack README. Oracle recommends that you print the
README for reference.

There will be an itemized part list within each of the packs and you will need to download all items in
order to have the complete download for the desired Oracle Agile release.

All Oracle Software Delivery Cloud files have been archived using Info-ZIP's highly portable Zip
utility. After downloading one or more of the archives, you will need the UnZip utility or the WinZip
utility to extract the files. You must unzip the archive on the platform for which it was intended.
Verify that the file size of your downloaded file matches the file size displayed on Oracle Software
Delivery Cloud. Unzip each Zip file to its own temporary directory.
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Obtaining Software from Oracle Support

Oracle minor release products are distributed as a Patchset/Minipack, which is an electronic version
of the software. To download the Product Patchset/Minipack, go to the My Oracle Support
https://support.oracle.com web site and search for the product. Refer to the description and review
the Readme. After you review the Readme, download the Product Patchset/Minipack.

There will be one zip file which contains all Product binaries, documentation, and database files.
Follow the installation instructions from the Install Guide to install the product.

Downloading the Agile PLM Software

To download the software from Oracle Support:
1. Log in and perform a search for the product using the search parameters provided.
2. Click the Download Now icon to download the software.

3. Extract the contents of the media pack and navigate to the DB_Installer folder. DB installers for
all platforms are made available within the DB_Installer folder, regardless of the operating
system on which you have chosen to install Agile PLM.

2 Agile Product Lifecycle Management


https://support.oracle.com/

Chapter 2
Agile System Requirements

This chapter includes the following:

= Operating SyStem REQUIMEMENES. ........c.iiririiriiiiieeeeeeee ettt 3
B Hardware REQUITEMENES ...ttt ettt et ese e es e e 4
= Database Hardware Configuration.............coeiiiiiiiiiiiieeeeeee et 6
I a0 Y| D 070] 1110 [V - o TSRS 7
5 DiSK /O CONfIGUIALIONS ...ttt ettt e esere e e s 8

Agile PLM 9.3.2 may be deployed in different configurations. The amount of time required to
complete an installation depends on the complexity of your Agile PLM deployment.

Note  Forinstallations using a certified localized language, all server components must be
installed on computers running the same localized OS. Clients can be running on the
same localized OS or English OS. For detailed information about using Agile with
international operating systems, refer to the Agile support
http://www.oracle.com/agile/support.html web site
(http://www.oracle.com/agile/support.html).

Agile can be distributed over a wide-area network with multiple servers or can be limited to one or
two server computers with several client computers. In the latter case, Agile can usually be installed
within a half day. However, network-based systems are inherently complex, and some installations
require additional time.

Agile recommends installing Oracle Database Server on a separate computer from the other Agile
components.

It is acceptable to install multiple server components on the same computer if sufficient hardware
resources are available. However, the minimum hardware requirements must be increased based
on the number of server components installed on a single computer.

Operating System Requirements

You should install only supported versions of Agile components that are within the same release.
You should not attempt to install Agile components on unsupported operating systems. Contact
your Agile Solutions Consultant or Agile Technical Support for special requirements.

Operating System Version
Microsoft Windows Microsoft Windows Server 2008 R2 (64-bit)
Solaris Oracle Solaris 11 and 10 (SPARC64, x86-64)
Linux Oracle Enterprise Linux 6 and 5 (32-bit, 64-bit)

Red Hat Enterprise Linux 6 and 5 (32-bit, 64-bit)
SUSE Linux 11 and 10 (32-bit, 64-bit)

AIX IBM AIX 7.1 and 6.1 (POWER 64-bit)



http://www.oracle.com/agile/support.html
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Operating System Version

VM Oracle VM'3 with OEL and Windows Operating
Systems listed above

1. Refer to Oracle Support Note ‘Certified Software on Oracle VM'.

Hardware Requirements

Before you can install Agile server components, you must have at least 1 GB of disk space
available on the drive where the OS is installed, in addition to the minimum disk space requirements
specified in the Agile PLM Capacity Planning Guide.

Important Agile computers and databases should be dedicated to Agile and should not have
other software installed, unless otherwise specified. Do not attempt to include other
database schemas or use the Agile host server as the primary domain controller
(PDC) or dynamic host configuration protocol (DHCP) server.

Note  Disk compression must be disabled on the computers where Agile components are
installed.

When choosing a hardware configuration, consider the number of total users, the number of
concurrent users, the size of your database, the number of ECOs processed per day, and overall
activity level. If you have questions about your system, Agile Technical Support or your Agile
Solutions Consultant can give guidance on whether you should choose a small, medium, large, or
extra-large configuration.

It is recommended that the computer on which you are installing Agile components and the Oracle
database have at least two physical drives or two partitions. This allows you to place the operating
system on one drive and use the other drive for Agile or Oracle components.

The tables below provide summary information for minimum hardware requirements based on
database size.

Small database system ( less than 1 GB)

Hardware Windows, Linux Solaris (SPARC) AlIX

and Solaris (x86)

CPU Two 1.8 GHz Intel Two 1.5 GHz Two 1.5 GHz
Xeon or equivalent UltraSPARC IV POWERS5

RAM (GB) 1 1 1

Number and size Four 18 GB Four 18 GB Four 18 GB

of disks

(partitions)

Medium database system (1 GB to 4 GB)

4 Agile Product Lifecycle Management



Chapter 2: Agile System Requirements

Hardware Windows, Linux Solaris (SPARC) AIX
and Solaris (x86)
CPU Two 1.8 GHz Intel Two 1.5 GHz Two 1.5 GHz
Xeon or equivalent UltraSPARC IV POWERS
RAM (GB) 2 2 2
Number and size Four 18 GB Four 18 GB Four 18 GB
of disks
(partitions)
Large database system (4 GB to 16 GB)
Hardware Windows, Linux Solaris (SPARC) AIX
and Solaris (x86)
CPU Four 1.8 GHz Intel Four 1.5 GHz Four 1.5 GHz
Xeon or equivalent UltraSPARC IV POWERS
RAM (GB) 4 4 4
Number and size Nine 18 GB Nine 18 GB Nine 18 GB
of disks
(partitions)
Extra-large database system (16 GB+)
Hardware Windows, Linux Solaris (SPARC) AIX
and Solaris (x86)
CPU Eight 1.8 GHz Intel Eight 1.5 GHz Eight 1.5 GHz
Xeon or equivalent UltraSPARC IV POWERS5
RAM (GB) 8 8 8
Number and size Twelve 18 GB Twelve 18 GB Twelve 18 GB
of disks
(partitions)

Agile PLM 9.3.2 is certified on Oracle Database Server 11g R1, 11g R2 and 12g R1. An emalil
system based on SMTP or SMTP gateway is also required. Recommended database hardware
depends on your Agile system configuration.

If you have only single processor computers and anticipate high network traffic, then the database
and Agile Application Server should be installed on two different computers to avoid competition for
resources on a single computer, which would outweigh any advantage gained from reduced

network traffic.

Oracle recommends separate disks for the operating system and database.
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Database Hardware Configuration

Agile uses four database configurations (A through D), as shown in the following table. In addition,
the previous tables provide the minimum hardware configuration based on the database sizing
model. Each database configuration provides necessary hardware resources to support the Agile
database sizing model, for supported platforms.

Taking into account the hardware requirements specified in the following table, each configuration is
intended for a specific database sizing model. The minimum hardware requirements should be
followed to satisfy the Agile database installation. To increase the scalability and concurrency for
any configuration, provide additional CPUs, RAM, and disk space.

o Configuration A provides the initial hardware resources for implementing the small database
sizing model.

@ Configuration B provides the minimum hardware resources for implementing the medium
(regular) database sizing model.

@ Configuration C provides the minimum hardware resources for implementing the large
database sizing model.

o Configuration D provides the minimum hardware resources for implementing the extra-large
database sizing model.

Agile PLM Database Sizing Matrix

Agile DB Logged Database Server Hardware
Config- In Peak-
uration time
Active
Users
c R D c R D c R D c R D
P A | P A | P A | P A |
U M S U M S U M S U M S
K K K K
S S S S
D 1000 8 8 9 12 | 12 9 16 | 16 12 | 24 | 24 15
GB GB GB GB
c 500 4 4 4 8 8 9 8 8 1 12 | 12 12
GB GB GB GB
B 250 4 2 4 8 4 4 4 4 9
GB GB GB
A 100 2 1 4 2 2 4
GB GB

6 Agile Product Lifecycle Management




Chapter 2: Agile System Requirements

Agile DB Logged Database Server Hardware
Config- In Peak-
uration time
Active
Users
c R D c R D c R D c R D
P A | P A | P A | P A |
U M S U M S U M S U M S
K K K K
S S S S
Demo 1 1 5 1
GB
Database Sizing Model Small Medium Large Extra Large

Depending on the database sizing and configuration model you follow, the database could
potentially support the following:

@ Small database model
* Configuration A supports up to 100 concurrent users
* Configuration B supports up to 250 concurrent users
*  Configuration C supports up to 500 concurrent users
* Configuration D supports up to 1,000 concurrent users

o Medium (regular) database model
* Configuration A supports up to 100 concurrent users
* Configuration B supports up to 250 concurrent users
*  Configuration C supports up to 500 concurrent users
* Configuration D supports up to 1,000 concurrent users

o Large database model
* Configuration B supports up to 250 concurrent users
*  Configuration C supports up to 500 concurrent users
* Configuration D supports up to 1,000 concurrent users

o Extra-large database model
* Configuration C supports up to 500 concurrent users
* Configuration D supports up to 1,000 concurrent users

RAID Configuration

RAID 1 mirroring is recommended because of its increased tolerance for hardware fault and
minimal impact on write speed. RAID 0 is recommended for its potential to improve disk read/write
performance.
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Although the following section refers to one-disk, four-disk, nine-disk, and twelve-disk
configurations, a RAID 1 configuration may double the number of disks required. It should also be
noted that a combination of RAID 0 and RAID 1 (for example, RAID 10) is often the best
configuration. In fact, such a hardware configuration normally requires an external disk storage
enclosure.

RAID 5 is not recommended as a storage configuration for the Database Server transaction logs.
Instead, choose a storage configuration with mirroring and striping that does not adversely affect
write speed.

Disk 1/O Configurations

While the proper sizing of extents minimizes dynamic extensions in the same segments, disk 1/0
contention within the same logical tablespace or physical data file can also be harmful.

You can improve disk 1/0 performance for multiple disk configurations by spreading the 1/O burden
across multiple disk devices. The following sections describe the use of multiple disks for the Oracle
database server. It is always advisable to use more disks.

There are ten tablespaces in the Agile PLM database configuration: AGILE_DATAL,
AGILE_DATAZ2, AGILE_DATAS, AGILE_DATA4, and AGILE_DATAS for storage of Agile tables,
and AGILE_INDX1, AGILE_INDX2, AGILE_INDX3, AGILE_INDX4, and AGILE_INDX5 for storage
of Agile indexes.

Disks Disks Drive/ Oracle Home Tablespaces Redo Control
(no RAID) (RAID 1) | Mount Logfiles files
Point
Disk 0 Disk 0/1 Dor ORACLE_HOME | SYSAUX LOG1 Control
/u01 SYSTEM LOG? file01
TOOLS L0G3 Contol
UNDO LOG4 Control
TEMP file03
USERS
INDX
AGILE_DATA1
AGILE_DATA2
AGILE_DATA3
AGILE_DATA4
AGILE_DATA5
AGILE_INDX1
AGILE_INDX2
AGILE_INDX3
AGILE_INDX4

Agile Product Lifecycle Management




Chapter 2: Agile System Requirements

Disks Disks Drive/ Oracle Home Tablespaces Redo Control
(no RAID) (RAID 1) | Mount Logfiles files
Point
AGILE_INDX5
One-Disk

A one-disk configuration is best for a demonstration environment. This configuration can produce
the highest disk I/O contention. In addition, as both usage and database size increase, performance
significantly declines. The one-disk configuration is intended for demo database applications only,
and the configuration can be implemented as shown.

There is no beneficial gain from Optimal Flexible Architecture (OFA) for the one-disk configuration
from the perspective of disk I/O contention.

Four-Disk Configuration

A four-disk configuration is best for an enterprise-level implementation of Agile. A four-disk
configuration spreads the various data files, control files, and redo log files across multiple disk
devices.

First of all, the three control files can be mirrored onto three different disks for best recovery
protection.

Second, all potential I/O demand-intensive data files can be distributed onto their own separate
disk. Redo log files are patrtially isolated from the rest of the data files, as the log files can cause
significant I/O contention during transactions if they are sharing disks with other data files. The
UNDO data file is separated from the schema data files and log files as well, so 1/O contention
during import and upgrade can be minimized.

Third, the Agile schema tablespaces can be isolated from the rest of the SYSTEM, TEMP, TOOLS,
and UNDO data files.

Disks Disks Drive/ Oracle Home Tablespaces Redo Control
(no (RAID 1) | Mount Logfiles files
RAID) Point
Disk 0 Disk 0/1 Dor ORACLE_HOME | SYSAUX/SYSTEM/TO Control
fu01 OL/UNDO file01
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Disks Disks Drive/ Oracle Home Tablespaces Redo Control
(no (RAID 1) | Mount Logfiles files
RAID) Point
Disk 1 Disk 2/3 Eor TEMP/USERS/INDX Archive log Control
1u02 file file02
Disk 2 Disk 4/5 For AGILE_INDX1 LOG 1/2/3/4 | Control
/u03 AGILE_INDX2 file03
AGILE_INDX3
AGILE_INDX4
AGILE_DATA5
Disk 3 Disk 6/7 Gor AGILE_DATA1
Juod AGILE_DATA2
AGILE_DATA3
AGILE_DATA4
AGILE_INDX5

The four-disk configuration shown is recommended. For production database sites, the four-disk
configuration represents the minimum requirements for an OFA implementation and provides the
minimum hardware configuration for performance tuning.

Nine-Disk Configuration

In addition to the advantages associated with a four-disk configuration, a nine-disk configuration
supports an enterprise-level implementation of Agile by further spreading various data files and redo
log files across multiple disk devices.

Application schema can obtain additional performance gains in terms of I/O load spread by further
separating the data and index files because of potential I/O contention between the AGILE_DATA
data files and AGILE_INDX data files. For supporting a full text search content index, a complete
separation of potential large data files in its own disk spindle should help I/O contention as physical
disk 1/0O is inevitable, due to the increasing amount of data, as shown in the following table.

Disks Disks Drive/ | Oracle Home Tablespaces Redo Control
(no (RAID | Mount Logfiles files
RAID) 1) Point
Disk 0 Disk 0/1 Cor ORACLE_HOME SYSTEM/TOOL/UNDO
u01
Disk 1 Disk2/3 | Dor TEMP/USERS/INDX Control
fu02 file01
Disk 2 Disk 4/5 Eor LOG Control
/u03 1/2/3/4 file02
Disk 3 Disk 6/7 For Archive Control
10 Agile Product Lifecycle Management




Chapter 2: Agile System Requirements

Disks Disks | Drive/ | Oracle Home Tablespaces Redo Control
(no (RAID | Mount Logfiles files
RAID) | 1) | Point
fu04 log file file03
Disk4 | Disk8/9 | Gor AGILE_DATA1
Juos AGILE_INDX2
Disk5 | Disk Hor AGILE_DATA?
101 Juob AGILE_INDX3
Disk6 | Disk lor AGILE_DATA3
1213 | o7 AGILE_INDX1
Disk7 | Disk Jor AGILE_DATA4
115 /08 AGILE_INDX5
Disk8 | Disk K or AGILE_INDX4
1617 | Ju09 AGILE_DATA5

Twelve-Disk Configuration

Further separating the AGILE_DATA and AGILE_INDX tablespaces, twelve-disk configurations can
be implemented as shown. This results in completely independent spindles for each data file and
index file.

Disks Disks Drives/ Oracle Home Tablespaces Redo Control
(no (RAID 1) Mount Logfiles files
RAID) Points
Disk 0 Disk 0/1 C or /u01 ORACLE_HOME
Disk 1 Disk 2/3 D or /u02 SYSTEM/TOOL/ Control
UNDO/TEMP/IN file01
DX
Disk 2 Disk 4/5 E or /u03 AGILE_DATA5 LOG Control
1/2/3/4 file02
Disk 3 Disk 6/7 F or /u04 USERS Archive Control
logfile file03
Disk 4 Disk 8/9 G or/u05 AGILE_DATA1
Disk 5 Disk 10/11 H or /u06 AGILE_DATA2
Disk 6 Disk 12/13 | or /u07 AGILE_DATA3
Disk 7 Disk 14/15 Jor/u08 AGILE_DATA4
Disk 8 Disk 16/17 K or /u09 AGILE_INDX1
Disk 9 Disk 18/19 L or /u10 AGILE_INDX2

11
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Disks Disks Drives/ Oracle Home Tablespaces Redo Control
(no (RAID 1) Mount Logfiles files
RAID) Points
Disk 10 Disk 20/21 M or/u11 AGILE_INDX3
Disk 11 Disk 22/23 N or /u12 AGILE_INDX4
AGILE_INDX5
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This chapter includes the following:

= Related DOCUMENTALION. ..ottt et et 13
= Before Installing Oracle Database Server on WINAOWS...........cocoviiiiiiiiiiiieeeeeee s 13

Before you install the Agile database, you must install the Oracle Database Server. You can
download the Oracle Database Server Installer for major releases fromQOracle Software Delivery
Cloud (http://edelivery.oracle.com), and for a Patchset/Minipack, you can download from Oracle
Support (https://support.oracle.com). Download instructions for each Oracle version/operating
system are provided on the download page.

For detailed instructions on how to install a particular Oracle Database Server version, refer to the
appropriate Installation Guides listed in the Oracle Documentation
(http://mwww.oracle.com/technology/documentation/index.html) web page.

Note  After you install Oracle Database Server, you must install the Example products into your
ORACLE_HOME, available at the download location. In a RAC environment, these
products should be installed on all nodes. These products include some files required to
create the Agile schema successfully.

Note  Make sure you select the database binaries that are compatible with the hardware you
are using.

Related Documentation

Before you begin, it is important to be familiar with all the information about installing the Oracle
database on different operating systems, and with the Optimal Flexible Architecture (OFA)
reference material for administrators. You can review the information pertaining to your Oracle
database server version at Oracle Documentation
(http://mww.oracle.com/technology/documentation/index.html).

Agile has made every attempt to be OFA-compliant. Any deviations from OFA guidelines are noted.

Before Installing Oracle Database Server on Windows

Before installing Oracle, you must:
@ Verify that Windows has been configured correctly.

@ Check to see that the Microsoft NTFS file system is used instead of FAT or FAT32, and convert
the file system if necessary. See Checking the Windows File System on page 14 for directions.

o Determine the name of the Windows computer where Oracle is to be installed.
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Note Itis recommended that the computer on which you are installing the Oracle
database have at least two physical drives or two partitions. This allows you to place
the operating system on the C drive and use the D drive for Oracle components.
The examples in this chapter use a C and D drive.

o Be sure that you have Administrator privileges within Windows on the computers where you are
installing Oracle and Agile PLM.

o Disable disk compression, if you are using it.

o Disable virus protection, if you are using it. Components used in the installer can be falsely
identified as being infected and lock up the installation. You can turn the virus protection on
after the installation is complete.

The following sections provide more information about these procedures.

Network Check

Before proceeding, it is important to confirm two settings to prevent difficulties from occurring.
Confirming Computer Name and Hostname

The computer where Oracle is installed must use the same value as both its computer name and its
DNS hostname. The following procedures can be used to identify the current values.

To determine the computer name for Windows:
1. Right-click the My Computer icon on the desktop, and choose Properties in the shortcut menu.
2. Inthe System Properties dialog box, click the Computer Name tab.

3. Note the name listed in the Full Computer Name field.

Note  Windows uses the same name for the computer name and DNS hostname.

Confirming the Server Date

It is important to adjust the date and time of the computer. The date and time need to be correct
when you work with your production data.

To confirm the date and time, click the Date/Time icon in the Windows Control Panel. Be sure to
verify the Time Zone setting, too.

Caution If you change the date or time after Agile PLM has been installed and started, you
need to stop and restart the server immediately after the change.

Checking the Windows File System

Agile recommends that servers use NTFS (NT File System) rather than FAT or FAT32 (File
Allocation Table), as NTFS is more robust.
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To determine the file system type:

1. Check the file system used on the computer. Choose Start > Administrative Tools > Computer
Management. Under Computer Management in the left pane, expand Storage and select Disk
Management.

The Disk Administration window opens.

There must be at least two partitions or hard drives. If your computer uses NTFS, proceed with
the Oracle installation. If your computer uses a FAT or FAT32 file system, Agile recommends
converting it to NTFS before proceeding.

Important Converting the file system deletes all current files on the drive. Backup all necessary
files before converting the file system to NTFS.

2. Right-click on the drive you want to reformat and choose Format in the shortcut menu.
3. Inthe File System field, change the file system type to NTFS.
4. Click Start.

The process takes several minutes. On completion, restart the system. You can proceed with the
Oracle installation.

For Servers Configured with DHCP

If your server is configured with DHCP (Dynamic Host Configuration Protocol), there is a known
issue with the Oracle Database Server installation. The installation fails and a warning message
displays.

There are two possible solutions:

o Copy the Oracle Database Server installation software to your local disk and perform an off-
network installation.

o |nstall the Microsoft Loopback adapter on the DHCP server, then add one entry to the hosts
file.

To install the Microsoft Loopback adapter:

1. Click Start > Control Panel > Add Hardware.

The Add Hardware wizard appears.

Click Next.

Choose Install the hardware that | manually select from a list (Advanced), and then click Next.
In the Common Hardware Types list, select Network adapters, then click Next.

In the Manufacturers list, select Microsoft.

In the Network Adapter list, select Microsoft Loopback Adapter, and then click Next.
Click Next to install the adapter.

Click Finish.

© N o o~ w D
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To configure the hosts file:
1. Open the hosts file, located at C:\Windows\System32\drivers\etc.
2. Add the following entry to the hosts file: 10.10.10.10 hostname.domain hostname

For example, if the full machine name of your database server is dbl.agile.agilesoft.com, the
entry in the hosts file would be:

10.10.10.10 dbl.agile.agilesoft.com dbl
3. Save thefile.

To configure the loopback IP address on the network:
1. Onthe database server, right-click the My Network Places icon.
2. Choose Properties to display the Network and Dial-up Connections window.

3. Locate a connection with the device name of Microsoft Loopback Adapter. This connection is
usually Local Area Connection 2.

4. Right-click this connection icon.
Choose Properties to display the Local Area Connection 2 Properties dialog box.

6. On the General tab, select Internet Protocol (TCP/IP), then click Properties to display the Internet
Protocol (TCP/IP) properties dialog box.

On the General tab, choose Use the following IP Address.
8. Enter the following values:

IP address: 10.10.10.10

Subnet mask: 255.255.255.0
9. Click OK.
10. Click Close.

On completion, restart the system. You can proceed with the Oracle installation.
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This chapter includes the following:
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To install the Agile database on Windows:

1. Within the installation folder, double-click the agile9320db_oracle.exe file to start the installation on
Windows. The Agile Database Configuration Utility appears.

2. Follow the instructions in Creating the Agile Database on Windows on page 17 to configure the
database.

3. Complete the post-installation steps described in Post-Installation Tasks on page 30

Installation Notes

For best results, as you install:

o Follow directions in the order in which they are given. Do not attempt to install any components
out of sequence.

o Oracle passwords and Agile passwords are case-sensitive. All other text entries, such as
schema names and folder names, are not case-sensitive. To avoid confusion, all passwords
and text entries in this guide appear in lowercase and should be typed as shown.

o When prompted for a hostname, type the fully qualified name for the host, not the short name.
For example, if a host is named dbo, type dbo.agile.com, not dbo.

Creating the Agile Database on Windows

The Agile Database Configuration Utility creates and configures the database used by Agile. To
start this utility, double-click the database installer executable file.

Drop-down lists that allow disk selection show the available disk space. If the space is a negative
value, you must select another drive.

Important If you change a default value, you must click in the field to ensure that the change is
activated.

To configure the database:

1. Inthe Destination Location dialog box of the Database Configuration Utility, accept the default
location, Agile9Tmp, or click Browse to specify a destination of your choice. This is the location
where template files are placed during the database installation. Throughout this document,
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this location is referred to as Agile9Tmp. Click Next.

In the Oracle Home dialog box, choose the appropriate ORACLE_HOME. This is the location
where the Oracle software was installed. If you have multiple Oracle Homes, make sure the
correct Oracle Home is selected in the list before continuing with the Database Configuration
Utility. Click Next.

In the Oracle SID dialog box, accept the default agile9 SID. If you want to change the SID, you
must use an ID that is 4 to 8 characters in length to uniquely identify the Oracle SID. If you
want to use an existing SID, you must remove it before you can re-use it. Click Next.

Note If you only want to generate database scripts (for example, to upgrade an existing
Agile schema), select the Generate database scripts only option. In this case, you
should use an existing SID. Follow onscreen directions to generate scripts. Note
that Agile Recipe & Material Workspace database scripts may also be generated if
you select this option.

In the Database Security and Agile User Information dialog box, set the Internal/Sys password,
SYSTEM password, CTXSYS password, Agile Schema Name, and Agile Schema Password.
Each password must be atleast 6 characters long.

Click Next.

In the Database Size Estimate dialog box, choose a database sizing model. New Agile
customers without an existing database to migrate should accept the default (Small). Click Next.

You can reselect a database sizing model depending on disk space available.
Note  Refer to the Capacity Planning Guide for database sizing information.
The next dialog provides an option to create and configure the Agile Recipe & Material (R&M)

Workspace database schema. If you do not want to create the R&M Workspace database
schema, skip this step and click Next.

To create the R&M Workspace database schema, select the Create Recipe & Material Workspace
schemas check box. Set the name and password for the RMW Owner Schema and the RMW
User Schema.

Click Next.

Note  Use the tables in the section Disk 1/O Configurations for guidance while performing steps

10.

7 through 10.

In the Tablespaces dialog box, accept the default, unless you have additional hard drives with
sufficient space available that allow you to distribute the files across multiple hard drives. If you
change the selection to a different drive location, click the letter of the drive to make sure it is
selected. Click Next.

In the Redo Log Files and Control Files dialog boxes, accept the default, unless you have
additional hard drives with sufficient space available that allow you to distribute the files across
multiple hard drives. Click Next.

If you accept the default location for the files on one drive, a message appears notifying you
about distributing the files across multiple drives (mirroring protection). If this is not an option,
click Next. Otherwise, click Back and reassign files to different hard drives.

In the Archive Log File dialog box, accept the default, unless you have additional hard drives
with sufficient space available that allow you to store the file on a different hard drive. Click

18
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11.

12.

13.

14.

Next.

In the Oracle Language Support dialog box, configure the NL.S_LENGTH_SEMANTICS
parameter to determine datatype storage allocation by the database server. The default value
is CHAR. Click Next.

Accept the default character set AL32UTFS. Click Next.

Note  For additional information about language support, refer to the Oracle Globalization
Support Guide.

A Command Prompt window displays briefly.

You are prompted to install the Agile database. Click Next.

The script runs in a Command Prompt window for a while.

When instance creation is complete, a confirmatory message appears. Click OK to complete the
process and exit.

Important Oracle recommends that you change all Oracle database user passwords after you

have created the Agile database. It is recommended to change these passwords
periodically for security purposes.

Agile supports Full Text Search (FTS). FTS is a feature enabled through Oracle Text. Because of
this feature, there is a fixed account, CTXSYS, referenced by some objects in the Agile schema.
For security purposes, you can change the CTXSYS account password from its default, CTXSYS,
to one of your own choice after Agile database creation and configuration.
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Preparing the Host Computer
This section describes how to prepare the installation environment on UNIX.
Preparation of the installation environment involves copying the Agile database utilities.:

To copy the Agile database utilities:

1. Login as the user that was used to install the Oracle database software and create a
temporary directory named “agile9320db:”

$ mkdir /home/oracle/agile9320db [Enter]

2. Download the appropriate Agile PLM media pack for your operating system to the agile9320db
directory. For more information on obtaining the media pack, see Obtaining Software from
Oracle Support on page 2 (for a Patchset/Minipack), or Obtaining Software from Oracle
Software Delivery Cloud on page 1 (for a major release).

3. Change to the agile9320db directory, and extract the files from the agile9320db_oracle.tar.gz file:
$ cd /home/oracle/agile9320db [Enter]
$ gunzip -c agile9320db_oracle.tar.gz|tar xvf - [Enter]
The agile9320db_oracle.tar file contains the following files:

* Qagile9database.sh - shell script for creating the database instance and generating the
database maintenance scripts

* agile9schema.dmp — agile schema dump file
¢ dbora — setup for the database automatic shutdown and startup

* pdgplm_plsgl.jar — Java stored procedures for the Enterprise Data Quality Product
integration

* profile.txt — oracle user .profile template
* Readme.txt — readme file
* system.txt — Solaris kernel parameters

Creating the Agile Database on UNIX

This section describes how to set up Oracle environment variables and create the default database
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instance and schema used by Agile using the Agile database creation utility.

To set up Oracle environment variables:

1.
2.

Log in as the user that was used to install the Oracle database software..
Create the environment parameter file .profile to include:
PATH=$PATH:/usr/local/bin:/usr/ccs/bin:/usr/openwin/bin:/usr/bin/X11
export PATH

ORACLE_HOME=<Location where you installed Oracle Database Server>
export ORACLE_HOME

For example:

(Oracle 11g)ORACLE_HOME=/u0l/app/oracle/product/11.1.0/db_1; export ORACLE_HOME
ORACLE_BASE=<Oracle base folder location>; export ORACLE_BASE
For example:

ORACLE_BASE=/u0l/app/oracle; export ORACLE_BASE
PATH=$PATH:3ORACLE_HOME/bin; export PATH

ORACLE_SID=agile9; export ORACLE_SID
NLS_LANG=AMERICAN_AMERICA.AL32UTFS8; export NLS_LANG

The environment variables settings above are stored in the file profile.txt included with the Agile
database utilities. If this is the first time you are configuring the host computer as a database
server, copy the profile.txt file to .profile:

$ cat agile9320db/profile.txt > .profile [Enter]
Set environment variables:
$ . Lprofile [Enter]

To start the installation:

1.

Log in to the computer as the user you created while preparing the installation environment.
For example, Oracle.

a. If necessary, edit the .profile file to change Oracle SID. By default, Agile uses agile9 as the
Oracle SID:
$ vi .profile [Enter]

b. Modify the value where ORACLE_SID=agile9 by replacing agile9 with the SID you want to
use.

Important Check the /var/opt/oracle/oratab file and make sure that the specified Oracle SID has

not been used. Specifying an existing Oracle SID can corrupt that database instance.

Note  The recommended SID length is 4-8 alphanumeric characters. (The default SID
‘agile9' is six characters.)

c. Source .profile to make the SID changes take effect:

. Lprofile [Enter]
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In a second terminal session, log in to the computer as the root user.
Create a directory named “oradata.”
Note  The agile9database.sh file uses a placeholder mount point /mpt. You must change
/mpt to match your mount points.
For example, if you have mount points at /u01 and /u02, you can create an oradata folder on
each mount point.
# mkdir -p /u01/oradata
# chown oracle:dba /u01/oradata

In the session where you are logged in as the Oracle user, create a $ORACLE_BASE/admin
directory:

$ mkdir -p /u01/appl/oracle/admin [Enter]
(Assuming ORACLE_BASE is set to /uO1/app/oracle.)

chown -R oracle:dba /u01/apploracle

You must now run the agile9database.sh script.

5.
6.

Change to the /home/oracle/agile9320db directory.
Modify the agile9database.sh script to match the mount points on your computer.

Note  Make sure ORACLE_SID matches the one you set for .profile, which should have
taken effect after you ran . ./.profile.

Note  The agile9database.sh file uses a placeholder mount point /mpt. You must change
/mpt to match your mount points.
The values in the script that can be modified appear in bold. You should limit your editing only
to these bold values.
Note  The following code lists variables in bold that you may want to revise besides
placeholder mount point /mpt.
#!/bin/sh
#
# AGILE9DB_BASE is the base directory for the OFA directories and maintenance scripts
# (create the directory before running this script)
# (default is SORACLE_BASE/admin/$ORACLE_SID)
#
AGILESDB_BASE=30RACLE_BASE/admin/$ORACLE_SID

# Parameters determine location of datafiles,
# controlfiles and logfiles

#

DATABASE_SYSTEM=/mpt/oradata/${ORACLE_SID} # SYSTEM tablespace mount
point
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DATABASE_SYSAUX=/mpt/oradata/${ORACLE_SID} # SYSAUX tablespace mount
point

DATABASE_TOOLS=/mpt/oradata/${ORACLE_SID} # TOOLS tablespace mount point
DATABASE_UNDO=/mpt/oradata/${ORACLE_SID} # RBS tablespace mount point
DATABASE_TEMP=/mpt/oradata/${ORACLE_SID} # TEMP tablespace mount point
DATABASE_USERS=/mpt/oradata/${ORACLE_SID} # USERS tablespace mount
point

DATABASE_INDX=/mpt/oradata/${ORACLE_SID} # INDX tablespace mount point
DATABASE_AGILE_DATAl=/mpt/oradata/${ORACLE_SID} # AGILE_DATAL tablespace
mount point

DATABASE_AGILE_INDX1=/mpt/oradata/${ORACLE_SID} # AGILE_INDX1 tablespace
mount point

DATABASE_AGILE_DATA2=/mpt/oradata/${ORACLE_SID} # AGILE_DATAZ2 tablespace
mount point

DATABASE_AGILE_INDX2=/mpt/oradata/${ORACLE_SID} # AGILE_INDX2 tablespace
mount point

DATABASE_AGILE_DATA3=/mpt/oradata/${ORACLE_SID} # AGILE_DATAZ3 tablespace
mount point

DATABASE_AGILE_INDX3=/mpt/oradata/${ORACLE_SID} # AGILE_INDXS3 tablespace
mount point

DATABASE_AGILE_DATA4=/mpt/oradata/${ORACLE_SID} # AGILE_DATAA4 tablespace
mount point

DATABASE_AGILE_INDX4=/mpt/oradata/${ORACLE_SID} # AGILE_INDX4 tablespace
mount point

DATABASE_AGILE_DATA5=/mpt/oradata/${ORACLE_SID} # AGILE_DATADS tablespace
mount point

DATABASE_AGILE_INDX5=/mpt/oradata/${ORACLE_SID} # AGILE_INDX5 tablespace
mount point

DATABASE_LOGFILES1=/mpt/oradata/${ORACLE_SID} # REDOLOG file 1 mount point
DATABASE_LOGFILES2=/mpt/oradata/${ORACLE_SID} # REDOLOG file 2 mount point
DATABASE_LOGFILES3=/mpt/oradata/${ORACLE_SID} # REDOLOG file 3 mount point
DATABASE_LOGFILES4=/mpt/oradata/${ORACLE_SID} # REDOLOG file 4 mount point
DATABASE_CONTROL1=/mpt/oradata/${ORACLE_SID} # CONTROL file 1 mount point
DATABASE_CONTROL2=/mpt/oradata/${ORACLE_SID} # CONTROL file 2 mount point
DATABASE_CONTROL3=/mpt/oradata/${ORACLE_SID} # CONTROL file 3 mount point

DATABASE_ARCHIVE=/mpt/oradata/${ORACLE_SID}/arch # ARCHIVELOGS
#

# Parameters determining: Character Set

#
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CHARACTER_SET=AL32UTF8
NATIONAL_CHARACTER_SET=AL16UTF16
NLS_LANG=American_America.AL32UTF8
#

7. Run the agile9database.sh script from the current directory:
$ Jagile9database.sh [Enter]

8. You are prompted about the database size that you want to install.

You should use the regular database size unless you have consulted with an Agile Solutions
Consultant or database administrator to ensure that the computer meets the minimum
requirements for the specified database size.

Note If you are unable to create files, make sure that all Oracle environment variables are
set correctly and that the 'oracle' user has full (read, write, and execute) privileges
on all directories referenced by agile9database.sh.

The script will run for a while.
Note  Oracle recommends that you change all Oracle database user passwords after you have

created the Agile database. It is recommended to change these passwords periodically
for security purposes.
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You can create a Real Application Clusters (RAC) database instance for Agile PLM using the
Oracle Database Configuration Assistant (DBCA), and then create an Agile PLM schema in that
database instance.

Creating an Oracle RAC Database Instance for Agile PLM

To create a RAC database instance:

1. Start the Oracle Database Configuration Assistant. (From the Start menu, navigate to All
Programs > Oracle — <Oracle Home> > Configuration and Migration Tools, and choose Database
Configuration Assistant). The Database Configuration Assistant: Welcome dialog appears.

Select the Oracle Real Application Clusters database option. Click Next.
In the Operations dialog, select Create a Database. Click Next.
In the Node Selection dialog, select all RAC nodes. Click Next.

In the Database Templates dialog, select Custom Database. Click Next.

o g WD

In the Database Identification dialog, enter values for the Global Database Name and SID
Prefix. For example, RAC.WORLD and RAC. Click Next.

7. In the Management Options dialog, click Next to accept the default selections. For more
information on Oracle Enterprise Manager, see related documentation on the Oracle
Technology Network (OTN) Web site http://www.oracle.com/technetwork/documentation/agile-
085940.html.

8. In the Database Credentials dialog, choose the Use the Same Password for All Accounts option.
You can change the passwords later. Enter a password and confirm it. Click Next.

9. Inthe Storage Options dialog, select your preferred storage option. The storage option that you
have on your system is automatically detected and appears selected. Click Next. Based on your
selection, the Database Configuration Assistant will present further options. Follow onscreen
directions to configure storage details.

10. Next, select the database components you require. In the Database Content dialog, under
Database Components, select the following:

®  Oracle Data Mining
®  Oracle Text
*  Enterprise Manager Repository (Optional)

Click Next.
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11. Inthe Database Services dialog, to accept the current configuration details, click Next.

Note At any stage, to change your selections, click Back and navigate to the appropriate
dialog.

12. In the Initialization Parameters dialog, under Memory, select Custom. Provide desired SGA and
PGA sizes or accept the default. Click Next.

13. In the Database Storage dialog, select the Tablespaces node. Create the following tablespaces
in the instance.

* AGILE_DATA1
* AGILE_DATA2
¢ AGILE_DATAS
* AGILE_DATA4
* AGILE_DATAS
* AGILE_INDX1
* AGILE_INDX2
* AGILE_INDX3
¢ AGILE_INDX4
¢ AGILE_INDX5

Note  Data files should be sized at least 1GB each with autoextend enabled, and must be
named as listed above. You can store the datafile at any location on your hard drive.
For guidance on sizing, refer to the tables in Disk I/O Configurations. AGILE_DATAS
and AGILE_INDXS5 tablespaces are required only if Recipe & Material Workspace is
being installed.

14. Review the storage parameters and click Next to accept.

15. In the Creation Options dialog, Create a Database is the default selection. Click Finish to accept
database creation settings.

16. In the Summary screen, click OK to start the database creation process.

17. Once the database creation is complete, a dialog appears with details of the newly created
database instance. Make a note of the information for your records. Within this dialog, click
Password Management and do the following:

a. Make sure that the CTXSYS account is not locked. If it is locked, log into Oracle as 'sys' or
'system' and execute the SQL command:
alter user ctxsys account unlock;
b. Set the following account passwords:
= sys/oracle
= system / manager
»  ctxsys/ ctxsys

You can change the passwords after schema creation is complete.

18. Click Exit. The RAC database instance creation is now complete.
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Creating an Agile PLM Schema in an Existing RAC or
Standalone Database Instance

The Oracle database stores data in virtual containers known as schemas. The Agile Database
Configuration Utility creates the database, user account, and schema used by Agile. Additional
schemas are not necessary; however, you can create additional Agile schemas with different user
names if necessary.

Note  You should not use the Oracle Security Manager to create users.

To create a schema in the RAC Database Instance:

On UNIX:

1. Run agile9database.sh and choose the Generate Maintenance Scripts Only option to generate the
Agile PLM 9.3.2 schema maintenance scripts.

2. Run recreateagile.sh to create the schema.

On Windows:
1. Run the database installer as described in Installing the Agile Database on Windows.

2. Intheinstaller screen where you specify the Oracle SID, select the Generate Database Scripts
Only check box. See Step 4 under Using the Agile Database Configuration Utility.

3. Follow onscreen instructions to generate scripts.

4. Run recreateagile.bat to create the schema.

There are three requirements around the package SYS.DBMS_SHARED_POOL for an Agile
database. If the requirements are not met, and the package DBMS_SHARED_ POOL does not exist
in the SYS schema, you may receive a DBMS shared pool error or AGILE9 _UTILS error.

To ensure that DBMS_SHARED_POOL requirements are met:
1. Log into the database as ‘sys’ user.
2. Run the following command:

SQL> describe SYS.DBMS_SHARED_POOL

3. If you receive an error indicating that the object SYS.DBMS_SHARED_ POOL does not exist,
run the SQL script dbmspool.sql located at ORACLE_HOME/RDBMS/admin.

4. As ‘sys’ user, grant execute privileges to the agile schema user.
SQL> grant execute on SYS.DBMS_SHARED_POOL to AGILE;
Where AGILE isthe agile schema user.

5. Connect to the database as the agile schema user, and run the following command:
SQL> create synonym DBMS_SHARED_POOL for SYS.DBMS_SHARED_POOL;

6. When the process completes, run the following command to compile the AGILE9_UTILS
package:

SQL> alter package agile9_utils compile body;
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The package should compile without errors. If the package compiles with errors, run the
following command and correct the same:

SQL> show errors

Post-Installation Tasks

This section describes mandatory and optional post-installation tasks to be completed, such as
configuring Oracle network connectivity and setting up additional Oracle functionality.

Adding and Configuring a Listener

If this is the first time Oracle has been installed on the current computer, you need to add and
configure a new database listener.

Note If you are creating a new Agile database on the same machine, you only need to add the
new database to the existing listener.

To add and configure a new Listener:

1. Start Oracle Net Manager:

®*  On Windows, choose Start > All Programs > <ORACLE_HOME> > Configuration and Migration
Tools > Net Manager.

*  On UNIX, run the command $ netmgr &.

2. Inthe Oracle Net Manager window, double-click the Local folder and select the Listeners folder.

3. Click Create il in the toolbar to add a listener.

The Choose Listener Name dialog box appears.

Click OK.

In the Listening Locations drop-down list, select Database Services.

Click Add Database.

In the dialog box that appears, make the following changes:

®  Global Database Name: agile9

®  Oracle Home Directory: <ORACLE_HOME>

e SID: agile9

Note If you used a different global database name or different home directory during the

database installation, change the information as appropriate.

7. Choose File > Save Network Configuration to save your changes.

8. Close Oracle Net Manager.

To restart the database listener, open a Command Prompt window and type Isnrctl reload.

30 Agile Product Lifecycle Management



Chapter 6: Post-Installation Tasks

Adding and Configuring a Net Service

1.

10.
11.
12.
13.

In the Oracle Net Manager window, double-click the Local folder and select the Service Naming
folder.

Click Create il in the toolbar to add a service name.

The Net Service Name Wizard starts.

In the Net Service Name field, type the name of the computer where the Oracle database is
located (usually the current computer). Click Next.

You are prompted to select a network protocol. Select TCP/IP (Internet Protocol) and click Next.

Type the name of the computer where Oracle is located in the Hostname field (the same name
you typed in step 3). Accept 1521 as the default port number. Click Next.

Select Oracle8i or later as the service name, and type agile9 in the field. Click Next.
Click Test to test the service.

The test initially fails because the default uses the incorrect login.

Click Change Login to reset the username and password.

Type agile in the Username field and tartan in the Password field. Click OK.

Click Test. You should now see a message indicating that the test was successful.
Click Close.

Click Finish to exit the Net Service Name Wizard.

From the Net Manager menu, choose File > Save Network Configuration to save the service name.

Setting Up Automatic Shutdown and Startup for the
Database on UNIX

To set up the Oracle database to automatically shut down and start up when the host
computer starts up and shuts down:

1.
2.

Log in the system as root.

Create a file named “dbora” in the /etc/init.d directory:

# cat /home/oracle/agile9320db/dbora > /etc/init.d/dbora [Enter]
Link to the dbora file:

# In -s /etc/init.d/dbora /etc/rc0.d/K10dbora [Enter]

# In -s letcfinit.d/dbora /etc/rc2.d/S99dbora [Enter]
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Setting Up Agile Recipe & Material Workspace
Prerequisites in the Agile Database

If you are installing Agile Recipe & Material Workspace along with Agile PLM, certain additional
tasks need to be completed in order to create the following information in the Agile database.

@ MaterialsSubclass subclass

o Recipe subclass

o Default Material ECO workflow

o Recipe & Material Workspace Ul Access privilege type

o Recipe & Material Workspace preferred Home Page setting

o Recipe & Material Workspace Admin AppliedTo property used in the Administrator role

To create these prerequisites in the Agile database, run the pharma.sql script located at

<ORACLE_BASE>\admin\<ORACLE_SID>\create\<agile schema user>.

Setting Up Optional Oracle Functionality

This section describes how to set up Oracle Net Manager and Oracle Enterprise Manager for
administrative purposes.

Setting Up Oracle Net Manager

If you use the TNS_ADMIN environment variable to specify the location of Oracle Network Services
configuration files (such as thsnames.ora), move the files located in the
$ORACLE_HOME/network/admin directory to the directory specified by TNS_ADMIN.

To set up Oracle Net Manager on UNIX:

1. Log in as root and change the ownership of the /var/opt/oracle directory:
# chown -R oracle:dba /var/opt/oracle [Enter]

2. Switch to the Oracle user, and change to the $ORACLE_HOME/network/admin directory:
# su - oracle [Enter]
$ cd SORACLE_HOME/network/admin [Enter]

3. Move all the files to the directory defined by environment parameter TNS_ADMIN, which is
/var/opt/oracle:

$ mv * /var/opt/oracle [Enter]

Configuring Oracle Enterprise Manager

You can use Database Control to perform many database administration and management tasks
including SQL performance tuning.
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To configure the Oracle network connection:
On Windows: Choose Start > All Programs > Oracle - <ORACLE_HOME> > Configuration and Migration

1.

10.
11.
12.
13.

Tools > Database Configuration Assistant.

On Unix: Run the command $ dbca &.

The Welcome screen appears.

Click Next.

Choose Configure Database Options on the Operations page. Click Next.
The Database page appears

Select the agile9 database you just created. Click Next.

The Management Options page appears.

Check Configure the Database with Enterprise Manager. Click Next.

The Database Content page appears.

Accept the defaults. Click Next.

The Database Credentials page appears.

Enter a password for the DBSNMP and SYSMAN users. Click Next.
The Connection Mode page appears.

Select Dedicated Server Mode. Click Finish.

Click OK for confirmation. Database configuration begins.

When configuration completes, the Database Control URL displays. Make a note of this URL
because it is used to log in to the database.

Click OK to close the Database Configuration Assistant.
Open a web browser and enter the Database Control URL.
Type the User Name and Password of the Agile database. Click Login.

Click | agree to accept the license agreement and display the Database Control page.

You have now finished installing and configuring the Agile PLM Database.

Setting Lexer Preference

Based on your installation requirement, you have the option to choose either BASIC lexer or
WORLD lexer. The default lexer is BASIC. To overcome FTS limitations related to character
searches, customers using the Japanese lexer should change from BASIC to WORLD lexer.

To switch lexer preference:

1.
2.
3.

Stop the application server.
Run the database installer with the Generate maintenance scripts option selected.
Edit recreateagile.bat to switch the lexer.

Change: agile9_fts_prefs_lexer_basic.sqgl
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To:agile9_ fts_prefs_lexer_world.sqgl
Run recreateagile.bat.
Import customer data.

Restart the application server.

Setting up Enterprise Data Quality Product Integration
To set up integration between the Enterprise Data Quality Product and Agile PLM:
1. Enable Oracle JVM.

2. Run the agile9pdq_setup file, located in the SORACLE_BASE\admin\SID\create\agile
directory.
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It is important to protect your Agile data and system files from loss. This section describes basic
backup and recovery strategies and gives specific information about applying them to your Agile
system used with Oracle products.

The instructions in this section are for system and database administrators who need to manage the
Agile database.

Database Maintenance

This section provides database maintenance procedures.

Monthly Maintenance

As part of monthly maintenance activities, Oracle recommends the following:
o Rebuilding domain indexes to improve performance.

o Running Averify to check database integrity as well as tablespace free space.

Checking Database Space Allocation

Checking the tablespace data files in your Oracle database on a monthly basis can help determine
how close your database storage is to maximum capacity. If any or all of the tablespaces are at
least 90 percent, you should increase the disk space allocation for the specific tablespaces. One
method for accomplishing this is to increase the data file size for the corresponding tablespaces, as
follows:

1. Check the disk space for the hard drive where the Oracle database is located.

2. If there is less than 500 MB available, it is recommended that you increase disk space by
adding to or replacing the hard drive.

3. To check the tablespace data files, start the Enterprise Manager Console. The Oracle Enterprise
Manager Login dialog box appears.

Select Launch standalone and click OK.
Double-click the Databases folder and the name of the database.
6. Log in as follows, and then click OK:

Username: system
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Password: manager
Service: hostname (remote) or blank (local)
Connect As: normal

Note  Type the fully qualified hosthame of the computer in the Service field (or Host String in
some cases) if you are not logging in on the same computer where you have
installed Oracle or if you receive a TNS error message.

Under Storage > Tablespaces, select System, Temporary, Agile_DATA1-5, and Agile_INDX1-5.
Determine if the amount of disk space each tablespace is using exceeds 90 percent. Make
sure Agile_INDX4 has enough space for file content index synchronization.

Note If you need to increase the amount of available disk space, double-click the value in
the Size field.

The Edit Datafile dialog box appears. Increase the amount of available disk space, and then
click OK.

If possible, you should double the current disk space. If the disk space is not available on the
hard drive, you should consider upgrading your hardware.

Note Thisis a preventive and proactive measure, but is not required. All Agile
tablespaces automatically extend by 10MB whenever additional disk space is
needed and available.

Dynamic Versus Static IP Addresses

You can use dynamic IP addresses with “long-term lease” assignments, as well as static addresses,
for Oracle systems. For best results, do not change the hostname of computers in the system, and
use static IP addresses.

Database Backup

You should institute a routine backup of all file systems on all servers.

Database losses are unfortunate, but they can and do occur. They can result from hardware
failures, natural disasters, fire, power surges, and problems with administration and configuration.
Whatever their cause, your best protection against business disruption and permanent data loss is
an effective backup and recovery plan, applied as automatically as possible.

This chapter introduces several ways to back up and recover data. You will need additional
information to adequately administer and protect your database. You may need to do a cost/benefit
analysis to determine how often to back up critical data and to justify the labor, hardware, software,
and storage costs involved. The following documents may be helpful:

o

Oracle Database Backup and Recovery Basics (see Oracle Database Backup and Recovery
Basics -
http://www.oracle.com/pls/db111/portal.portal_db?selected=4&frame=#backup_and_recovery)

Oracle Database Recovery Manager User's Guide (see Oracle Database Backup and
Recovery Basics -
http://www.oracle.com/pls/db111/portal.portal_db?selected=4&frame=#backup_and_recovery)
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a

Oracle Database Concepts (see Oracle Database Concepts -
http://download.oracle.com/docs/cd/B28359 01/server.111/b28318/toc.htm)

Note  The documents are available on the Oracle Technology Network (OTN) Web site
http://www.oracle.com/technetwork/documentation/agile-085940.html.

You must be a member of the Oracle Technology Network to have access to the site (becoming a
member requires simply that you register at the site to gain access).

Backup and Recovery Strategy

When you are planning a backup and recovery strategy, you need to consider the following factors:

o

Database availability

What is the database availability requirement for business operations? Is it required for
7X24X365 availability or only during standard business hours?

According to the availability requirement, different database backup methods can be adopted. If
the database cannot be shut down, a hot online backup is the only choice.

ARCHIVELOG and NOARCHIVELOG mode

A database can run in ARCHIVELOG or NOARCHIVELOG mode. It is a best practice is to
have your PRODUCTION database in archive log mode. DEVELOPMENT and TEST
environments need not be in archive log mode since they can be refreshed using
PRODUCTION.

When the database is in operation, all database changes are recorded in redo log files. If the
database is running in ARCHIVELOG mode, these redo log files are archived in the database
archive log destination and are referred to as archived redo log files. A database running in
ARCHIVELOG mode provides better protection from data loss. It can be recovered up to the
point of failure. To perform a hot backup, a database must be running in ARCHIVELOG mode.

The default configuration for the Agile database is NOARCHIVELOG mode. You can change
the database to ARCHIVELOG mode following the instructions available in the initagile9.ora
file. It is recommended that an Oracle DBA or Oracle support be available.

Data loss tolerance
How much data can you afford to lose due to a database crash?

Can you afford to lose one day or one week’s worth of data in the event of a database crash?
Can you re-enter user data if there is a database failure?

If your database cannot tolerate data loss due to failure, then a good data protection backup
method needs to be adopted, such as hot or cold backup using ARCHIVELOG mode.

Recovery time
How much time can you afford to spend recovering a database in the event of a crash?

Different backup methods have different recovery times. Physical methods for backup and
recovery are much faster than logical backups, and backups to disk are much faster than to
tape. Recovery is also much faster from disk than from tape.

Technical skills

What are the technical skills of your database or systems administrator?
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Some backup methods require more database knowledge than others. Standby databases
require more technical skill than cold or hot backup.

@ Hardware or software investment
How much hardware or software investment do you want to put into the system?

Some advanced features, such as high availability, require more of an investment in hardware
and software.

You can determine the safest backup method for your environment based on database
requirements, database running mode, and your recovery scenario (as described in the following
table). However, the final decisions about the backup and recovery strategy you use are beyond the
scope of this chapter. For detailed information to help you make these decisions, see the books
listed on the previous page.

Scenario Backup methods

The database requires 7X24 uptime and cannot be Hot backup
shut down Export

Database must be running in ARCHIVELOG mode

The database is available during regular business Hot backup
hours and can be shutdown Cold backup
Export

Database can running in NOARCHIVELOG or
ARCHIVELOG mode

To recover up to the point of failure Hot backup
Cold backup with ARCHIVELOG mode

To recover an individual user or table Export

For fast recovery Hot backup
Cold backup

Implementing Backup Procedures

For best backup results, follow these guidelines:
@ Schedule online backups when there is minimal database access.
@ Test your backup strategy to see if it is effective; make changes if any area is weak.

@ Plan to save at least one version back; choose to retain enough versions for your business
needs.

@ Perform database consistency checks just before export or after import.

@ Back up the master database before and after it is altered; if you save the original database
creation scripts, you can use the same scripts to recreate it.
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o For a distributed system, plan on coordinating backup procedures so each site can be backed
up individually without destroying the integrity of the data at other sites.

Types of Backups

This section describes the following types of backups:
@ Registry file backups

o System backups

o Standby database backups

o Standard database backups

System administrators often perform the first two types of backups, and database administrators
(DBAS) perform the last two types of backups.

Backup procedures using third-party tools are not described in this chapter. However, if you are
using one, see “Useful Information for Backup and Maintenance Tools” for the default username
and other Oracle database information.

Performing System Backups

You typically perform a system backup on a small system. You bring down the entire system,
including all the programs, data files, and log files. Typically, a system backup is run each night.

To perform a system backup, shut down the system, start it up again in single-user or
maintenance mode, then copy system files to tape, as follows:

1. Shut down active applications.

Shut down the relational database.

Stop the Agile Application Server process.

Back up all file systems to an alternate storage device.
Start the Agile Application Server process.

Start the system in multi-user mode.

Restart the database.

© N o o D

Restart applications as needed.
Using Standby Databases

The standby database feature maintains a duplicate database of your primary online database at
the same location or at a remote site. (Both the standby database and the primary database must
be running on the same hardware platform, operating system, and Oracle patch release.) A standby
database acts as a backup when it resides locally, and is implemented as part of a database
disaster recovery strategy when it resides at a remote site. The standby database has the following
features:

@ ltis copied from the primary or current production database onto a system residing locally or
remotely.
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@ Itis mounted, but not open, and is in constant recovery mode.

o Redo log files generated from the primary database can be transported to the standby
database, and the standby database can apply these logs to recover the database.

o |Inthe event of a disaster, a standby database can be activated and fully functional as a new
production database.

A standby database takes time to set up and configure. For more information on standby
databases, see Oracle Data Guard Overview
http://www.oracle.com/technology/deploy/availability/htdocs/DataGuardOverview.html.

Performing Database Backups

Typically, you run a standard database backup daily. Databases backups can be:

o Cold or offline, where the database is shut down before copying database-related files: control
files, data files, redo log files, initial parameter file (initagile9.ora), spfileagile9.ora, and
password file (pwdagile9.ora). A database running in ARCHIVELOG or NOARCHIVELOG
mode can be backed up by a cold backup (NOARCHIVELOG mode permits only cold
backups).

o Hot or online, where a backup is performed while the database is open and users are
accessing it. To perform a hot backup, a database must be running in ARCHIVELOG mode.
When performing a hot backup, the database tablespace must first be put in backup mode,
then the datafile can be copied by the operating system. Once the datafile has been copied, the
database tablespace can be placed online again. This allows the database to be backed up
tablespace by tablespace. The archived log files must be backed up regularly as these are
needed for database recovery.

o Alogical backup creates logical copies of database objects in a binary export file. Logical
backups use the agile9 database utilities, agile9exp and agile9imp. When performing logical
backups, a database must be open and running.

Note  Oracle EXP and IMP utilities do not export the ctxsys account. So, FTS objects will
be recreated during an agile9 import.

For best results, you should timestamp backups and generate scripts to perform them automatically
using the operating system task schedule command.

Performing Cold Backups

Cold backups should be done on all the database-related files, including data files, control files,
redo log files, the initial parameter file (initagile9.ora), the password file (pwdagile9.ora), and the
server parameter file (spfileagile9.ora).

To perform a cold backup on all database-related files:
1. Shut down the database.

2. Use the operating system copy command to copy all of the database data files, the control file,
the initial parameter file, the password file, and the archived redo log file (if the database is
running in ARCHIVELOG mode) to the backup destination.

3. Restart the database.
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Performing Hot Backups

The archived log files must be backed up regularly as these are needed for database recovery.

Database Import and Export

You can import and export a database using either of the following means, based upon your
requirement:

o Oracle Data Pump - Ideal for very large Agile PLM databases. Enables very fast bulk data and
metadata movement between Oracle databases. Uses high-speed, parallel 'expdp’ and 'impdp'
utilities to move data. The following utilities are included in the Agile PLM installation folder for
import/export using Oracle Data Pump:

® agile9impdp
* agile9expdp

@ Import/ Export Utilities- Ideal for relatively small initial ‘schema dumps’ and for small databases.
Uses the Oracle Database Server ‘imp’ and ‘exp’ utilities to move data. The following utilities
are included in the installation folder for traditional import/export:

* agile9imp
* agile9exp

The import or export procedure for the Agile database remains the same in both cases. Only the
utilities called are different, as listed above. These procedures are outlined in the following sections.

The import process broadly includes the following actions:
1. Creating the Agile schema.

2. Organizing the schema.

3. Defining import parameters.
4

Running the import utility.

Creating the Agile Schema and Importing the Database

Before you import, ensure that you have taken a full backup of your Oracle database or of the Agile
schema, as described in Exporting the Database on page 46.

Note If you are prompted for the service name or host string, you must provide the fully
qualified computer name.

To create the Agile schema and import the database on Windows:

1. Confirm that the schema is valid. If you do not already have the 9.3.2 maintenance scripts
generated, run the database installer with the Generate database scripts only option selected as
described in Using the Agile Database Configuration Utility. Follow onscreen prompts to
complete script generation.

2. Next, to ensure that the schema is organized correctly, type the following in a Command
Prompt window:
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cd oracleladmin\<Oracle_SID>\create\<agile schema user>
recreateagile.bat
Note Running this command will drop the existing Agile schema (if any) as well as any
data that it contains.

3. Check import parameters in the .par file:
®  For traditional import: agile9imp.par
For Oracle Data Pump import: agile9impdp.par and agile9impdp_seq_trig.par

These parameters are described in Import Parameters on page 43.

4. Toimport the database and recreate indexes and statistics, run the following batch file:
®  For traditional import: agile9imp.bat
*  For Oracle Data Pump import: agile9impdp.bat

5. After the batch file finishes running, type Exit to close the Command Prompt window.

Note For file content index synchronization, call Agile Technical Support.

To create the Agile schema and import the database on UNIX:
1. Log in as the user used to install the Oracle database software..
Confirm that the database schema is valid.

Confirm that the user account name is new.

Make a backup of the existing database schema.

a > 0D

Change to the oracle user directory:

$cd

6. Copy agile9database from the agile9320db directory:
$ cp ./agile9320db/agile9database.sh

7. Edit the agile9database shell script, and find AGTLE=agile.
Change agile to the new, unused account name.

9. Save and close the file.

10. Run agile9database:

$ chmod u+x agile9database.sh

$ Jagile9database.sh

You are prompted to choose a database size. Enter D for demo, S for small, M for medium, L
for large, or X for extra large, based on how you created the database initially.

The script creates several SQL scripts and Bourne shell scripts in the following directory:
$ORACLE_BASE/admin/$ORACLE_SID/create/<agile schema user>.

11. When the script finishes running, type the following:
$ cd SORACLE_BASE/admin/$ORACLE_SID/create/<agile schema user>
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12.

13.

14.

15.

Run recreateagile:

$ chmod u+x recreateagile.sh

$ Jrecreateagile.sh

Note Running this command will drop the existing Agile schema (if any) as well as any
data that it contains.

Check import parameters in the .par file:

®  For traditional import: agile9imp.par

® For Oracle Data Pump import: agile9impdp.par

These parameters are described in Import Parameters on page 43.
To import the database and recreate indexes and statistics, run the following batch file:
*  For traditional import: agile9imp.sh
* For Oracle Data Pump import: agile9impdp.sh
To import the schema and recreate indexes and statistics, run the following commands:
® For traditional import:
$ chmod u+x agile9imp.sh
$ Jagile9imp.sh
*  For Oracle Data Pump import:
$ chmod u+x agile9impdp.sh
$ .Jagile9impdp.sh

For file content index synchronization, call Agile Technical Support.

Import Parameters

Import parameters are specified within the files listed in the table below. These files are located in
the database instance folder along with the import utilities.

agile9imp.par

Parameter Description

file The file to import. The dump file schema version must match the latest agile schema version.

log The import log file.

fromuser The user account in the file that contains the data that will be imported. £romuser must exist
in the dump file specified by the file.

touser The user account where the data is being imported. touser must match the current value of
%AGILE%; otherwise, importing the data may cause data corruption.
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Note  Other parameters such as indexes, rows, ignore, grants, constraints, and statistics specify
other import settings. Do not modify these parameters, and these settings should only be
used when using the agile9imp utility. If a standalone imp is used, do not use these
settings.

agile9impdp.par

Parameter Description

directory The directory object that identifies the location of the import files.

dumpfile The dump file to import. The dump file schema version must match the latest agile schema
version.

logfile The import log file.

content The data to import. The default value is data_only. Toimport to a new schema, first

generate maintenance scripts for that schema, run recreateagile to create the schema objects,
and then add the parameter remap_schema=<fromuser>:<touser>.

parallel The number of import processes that should be run in parallel.

Note This parameter is supported only for Oracle Enterprise Edition. For other versions, this
parameter must be removed from the .par file.

agile9impdp_seq_trig.par

Parameter Description
directory The directory object that identifies the location of the import files.
dumpfile The dump file to import. The dump file schema version must match the latest agile schema
version.
logfile The import log file.
include Specifies that sequences and triggers are to be imported.

Deleting an Instance and the Database Files

Before creating a new instance, you must delete the existing instance (such as agile9).

1. Make sure the Oracle Listener and Agile9 service are running. (Agile9 is the Oracle service if
your SID is Agile9.)

Start the Database Configuration Assistant.

3. Select Delete a Database, and click Next.
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The instance you want to delete (Agile9) should appear in the Available Instances field.
Select the instance.

Type the username (sys) and password (oracle), if necessary.

Click Finish.

You are prompted to confirm the deletion, and then a message appears confirming that the
instance has been removed.

8. Confirm that the agile9-related password file, spfile, and init files in the $ORACLE_HOME/dbs
folder on Solaris have been deleted.

N o g A

9. Confirm that the agile9-related password file, spfile, and init files in the
%ORACLE_HOME\database folder on Windows have been deleted.

Note  After dropping a database instance using the Database Configuration Assistant, the
TEMP tablespace must be removed manually.

Running SQL Scripts Against the Agile PLM Schema

Important Before running a script, make sure you have a current backup (export) of your Agile
database. For instructions on exporting (creating a DMP backup of your Agile
database), refer to your Oracle documentation or Help system.

To run an SQL script against an Oracle database on Windows:

1. Create a new directory called "scripts" under the oracle\admin\agile9\create\<agile schema user>
directory. Where agile9 is your Oracle SID.

Copy the SQL script to the scripts folder.
On the computer where Oracle is installed, start SQL Plus in a command prompt window.

Type the login ID and password (the defaults are agile and tartan).

a r wDN

Before running the script, create a spool file to record and contain the results from issuing the
SQL script. At the SQL prompt type:

spool d:\oracle\admin\agile9\create\<agile schema user>\scripts\<file name>.Ist
For example: spool d:\oracleladmin\agile9\create\<agile schema user>\scripts\averifyresults.lst

Note  The file with the LST extension is any filename that you want to use to identify the
file that will contain these results. It is best and easiest to give the LST file the same
name as the filename that is attached to the SQL file.

For example, if the SQL file to be run is oracle_averify90.sql, then name the spool file
oracle_averify90.Ist. You can also specify a drive or location other than what is shown in the
previous example.

The drive and location specified are where the spool file will be saved.
6. Issue the command to run the SQL script by typing the following at the SQL prompt:

@d:\oracle\admin\agile9\create\<agile schema user>\scripts\<file name>.sq|l
For example: @d:\oracle\admin\agile9\create\<agile schema user>\scripts\oracle_averify90.sql

Note  The @ symbol must be typed directly in front of this command line.
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9.

The file with the SQL extension is the name of the specific SQL file to be issued against the
database. Depending on where the SQL file is located on the server, you will also specify the
drive and location, which could be something other than the d:\oracle\admin\agile9\create\scripts
shown in the example.

Notice the process of the script being executed. When it is complete, there will be an indication
of “commit, complete.”

At the SQL prompt, type the following: spool off
Close the SQL Plus window and exit SQL Plus.

Note In some cases where a change is being made to the database, you may need to
stop and restart both Agile services for the change to take effect. If this is necessary,
you will be advised at the time the script is provided. In the case of issuing scripts
that do not make changes to the database scripts (for example, oracle_averify.sql
scripts), restarting the Agile services is not necessary.

Locate and open the spool file created in step 5, if necessary.

The file can be opened within an application such as Notepad so that results can be viewed and
printed, if necessary.

Exporting the Database

For maximum data security, you should use a cold backup. You can import the Agile schema DMP
file whenever you need to restore a database or replicate it on another computer with the exception
of file content index synchronization because of its dependence on the file system.

If you are copying or moving the Agile schema to another computer, you need to set up the
computer before importing the Agile schema.

You can perform either of the following types of export:

o

o

Export the Agile schema alone - This is much faster than exporting the whole database.

Full export - Export all the schemas in the Oracle database.

Important If you are prompted for the service name or host string during the export, you must

provide the fully qualified computer name.

Exporting the Agile Schema from Oracle

To export only the Agile schema on Windows:

1. Ensure that all users are logged off before shutting down the application server.
Note  The following commands use the D drive. If you have installed agile9320db or
Oracle on another drive, specify that drive letter.
2. Open a Command Prompt window, and type the following:
d:
cd \oracleladmin\<Oracle SID>\create\<agile schema user>
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Check export parameters in the .par file.
®  For traditional export: agile9exp.par
® For Oracle Data Pump export: agile9expdp.par

These parameters are described in Export Parameters on page 48.

To export the database, run the following batch file:
* For traditional export: agile9exp.bat
*  For Oracle Data Pump export: agile9expdp.bat

To export only the Agile schema on UNIX:

1.

Ensure that all users are logged off. The easiest way to do this is to disconnect the server from
the network.

Change to the directory where the Agile scripts are located:

$ cd $ORACLE_BASE/admin/$ORACLE_SID/create/<agile schema user>
Check export parameters in the .par file.

*  For traditional export: agile9exp.par

* For Oracle Data Pump export: agile9expdp.par

These parameters are described in Export Parameters on page 48.

To export the database, run the following commands:
*  For traditional import:
$ chmod u+x agile9exp.sh

$ Jagile9exp.sh
* For Oracle Data Pump import:

$ chmod u+x agile9expdp.sh
$ .Jagile9expdp.sh

The database export takes awhile. When it is complete, open the log file and see if the export was
successful. If there were problems, call Agile Technical Support.

You can copy the successful export of expdat.dmp to another secure computer as a backup.

Note If you cannot export empty tables on version 11.2.0.1.0 of the Oracle database, there are

three options to help resolve this problem:

Note 1. Apply a patch to upgrade the database to version 11.2.0.3.0 or later OR

Note 2. RunALTER TABLE ALLOCATE EXTENT on each empty table that is not exporting

OR

Note 3. Setthe deferred_segment_creation parameter to FALSE in the database

instance and recreate the schema.
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Exporting the Full Oracle Database

To export the full Oracle database on Windows:

1. Ensure that all system users are logged off. The easiest way to do this is to disconnect the
server from the network.

2. Open a Command Prompt window.
3. Set the character set:
NLS_LANG=AMERICAN AMERICA.AL32UTF8

4. Type the following text with spaces and a triple set of quotes as indicated (do not press Enter
until you have typed the whole text string):

exp system/manager full=y file="""<drive>:\Agile9Tmp\<exp_filename>.dmp”””
log="""drive:\Agile9Tmp\<exp_filename>.log""”

Agile recommends naming the export file expfull.dmp. For example:

exp system/manager full=y file="""d:\Agile9Tmp\expfull.dmp"" log="""d:\Agile9Tmp\expfull.log

To export the full Oracle database on UNIX:

1. Ensure that all system users are logged off. The easiest way to do this is to disconnect the
server from the network.

2. Enter the following command:

$ exp system/manager full=y file/nome/oracle/agile9320db/ <exp_filename>.dmp
log=/home/oracle/agile9320db/<exp_filename>.log

Agile recommends naming the export file expfull.dmp. For example:

exp system/manager full=y file=lhome/oracle/agile9320db/expfull.dmp
log=/homeloracle/agile9320db/expfull.log

The database export takes a while. When it completes, open the log file and see if the export was
successful. If there were problems, call Agile Technical Support.

You can copy the successful export of expfull.dmp to another secure computer as a backup.

Export Parameters

agile9exp.par

file The file to export.
log The export log file.
owner The user account that contains the data to export.

agile9expdp.par
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directory The directory object that identifies the location of the import files.
dumpfile The dump file to export.

logfile The export log file.

schemas The names of the schemas to export.

Database Recovery

In the case of failure, database recovery uses a previous database backup to recreate a database
that is as complete, accurate, and up-to-date as possible. Database recovery depends on the
database backup method. Two backup methods are standard backup and logical backup.

o For standard backup, including cold and hot backup, database recovery requires the use of the
operating system copy command to restore backed up datafiles.

¢ If the database is running in NOARCHIVELOG mode, there are no backed up archive log
files. Recovery is to restore a previously backed up data file, control file, initial parameter
file, and password file. No redo log files are applied and no database roll forward is
needed. In this scenario, a database can be recovered up to the last backup.

¢ [f the database is running ARCHIVELOG mode, database recovery is to restore previous
backed up database files up to the last archived log files. When recovering a database,
these archived log files are applied and the database is rolled forward. In this scenario, a
database can be recovered up to the point of database failure.

o For alogical backup, a database recovery involves importing the database or schema from a
previous export DMP file. For a logical backup, there is no roll forward involved.

Database recovery can be performed by using Oracle Recovery Manager.

Using Oracle Recovery Manager

You can use the Oracle Recovery Manager to perform an automatic recovery, restore the full
database, restore a data file, or restore a control file.

The major advantage for Oracle Recovery Manager (RMAN) is that it can perform incremental
database backup and recovery. Incremental backup and recovery is much faster than a full
database backup and recovery, especially for large database systems. RMAN is more complicated
to setup compared with a standard backup.

49



Database Installation Guide

50

Agile Product Lifecycle Management



	Copyright and Trademarks
	Overview of Agile Database Installation
	Task Overview
	Obtaining Software from Oracle Software Delivery Cloud
	Obtaining Software from Oracle Support
	Downloading the Agile PLM Software


	Agile System Requirements
	Operating System Requirements
	Hardware Requirements
	Database Hardware Configuration
	RAID Configuration
	Disk I/O Configurations
	One-Disk
	Four-Disk Configuration
	Nine-Disk Configuration
	Twelve-Disk Configuration


	Installing Oracle Database Server
	Related Documentation
	Before Installing Oracle Database Server on Windows
	Network Check
	Confirming Computer Name and Hostname
	Confirming the Server Date

	Checking the Windows File System
	For Servers Configured with DHCP


	Installing the Agile Database on Windows
	Installation Notes
	Creating the Agile Database on Windows

	Installing the Agile Database on UNIX
	Preparing the Host Computer
	Creating the Agile Database on UNIX

	Creating a RAC Database and Schema for Agile PLM
	Creating an Oracle RAC Database Instance for Agile PLM
	Creating an Agile PLM Schema in an Existing RAC or Standalone Database Instance

	Post-Installation Tasks
	Adding and Configuring a Listener
	Adding and Configuring a Net Service
	Setting Up Automatic Shutdown and Startup for the Database on UNIX
	Setting Up Agile Recipe & Material Workspace Prerequisites in the Agile Database
	Setting Up Optional Oracle Functionality
	Setting Up Oracle Net Manager
	Configuring Oracle Enterprise Manager

	Setting Lexer Preference
	Setting up Enterprise Data Quality Product Integration

	Database Management
	Database Maintenance
	Monthly Maintenance
	Checking Database Space Allocation
	Dynamic Versus Static IP Addresses

	Database Backup
	Backup and Recovery Strategy
	Implementing Backup Procedures
	Types of Backups
	Performing System Backups
	Using Standby Databases
	Performing Database Backups
	Performing Cold Backups
	Performing Hot Backups


	Database Import and Export
	Creating the Agile Schema and Importing the Database
	Import Parameters
	Deleting an Instance and the Database Files
	Running SQL Scripts Against the Agile PLM Schema

	Exporting the Database
	Exporting the Agile Schema from Oracle
	Exporting the Full Oracle Database
	Export Parameters


	Database Recovery
	Using Oracle Recovery Manager





